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Abstract :

The advent of new technologies in the field of contemporary art opened up the possibility for
artists to combine a variety of media, including text, music, painting, design and video or film,
to make new, interdisciplinary artforms with new and unique energies. The diversity of forms
used to create these multimedia works means that the response to the work is equally diverse
- it can be seen as pure fun, or a game, or thought-provoking, or educational or simply
aesthetically pleasing. But how are those different media combined to create that multiplicity
of responses? This study will analyse the concept of interactivity in contemporary art, bringing
together the inspirational, the creative and the aesthetic components of the form, by
investigating the concept of new media art.

Keywords: Interactive; New Media Art; Contemporary Art
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Abstract

Ever since the information revolution after 1960s, creation via digital
computer design has been a significant form in contemporary art. However, the
controversies surrounding this new form of art have never ceased after video and
new media art made their fist debut at an international art exhibition in 1980s.
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The discord results from a rupture between traditional art and new media because
the latter, on one hand, features the novelty of advanced digital technology and,
on the other hand, includes the irresistible real-time experiences and interactive
effects.  Today, the new media is still characterized by cross-subject
collaboration (as the creation between artists and engineers), new-technological
experiments (as the new sensor devices and equipments), the combination of art
and commercial development (as art and fashion), theater performance (as the
combination of stage space and new media image) and so on. All of them
advocate a new coalition between creative thinking and technological potential.
Nevertheless, how could the western new media art embodies the oriental
creative concept in terms of viewers’ participation in the creative work? To be
more specific, how can it be possible for viewers to fully understand the artists’
contemplation on the meditation experience and their Zenistic concept when their
directly interact with the art work by touching them, feeling the space transition,
experiencing voice control or the interplay between light and shadow? Hence,
the study enveadors to discuss new media in terms of Zenistic expression. It will
induce the interaction between new media and oriental Zenism by analyzing the
artists’ creative thoughts, ways of approach, and content of creation under the
oriental and occidental cultural differences.

Key words: Zenism ; New Media Art ; Interactive Installation ; Contemporary Art
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i BRERER @ RINtRECE S EMRITES - MENESIDRERDIR
BICE - SHRKE THEEAEHRR BEERRB O REEHRES

(Hyperreality ) &0k - 757525 ( Jean Baudrillard ) [} T#3& | ( Simulation ) &)
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F—Z - Processing B2 56

[Webcam SR51RE8RUF 1 TFLH

N ]

1-1. Processing 12 &/

1-2. Processing BVfRIEIRE

1-3. Sketch &3

1-4. Applet (EH

1-5. Application (& H]

1-6. TERFN

1-7. FBRBIERR

1-8. HEERERR

1-9. Fi2 4248 (Programming Modes )
1-10. FBESET, (Rendering Modes )
1-11. EAEINEHE

1-12. EPSIZIVEE

1-13. #237\ /& (Processing API)

1-14. 3TE{PEHER

1-1. Processing 12T, &

#3311 http://processing.org/

Processing 2 —{BRNRBIRNIZEIESKERERE  REGCEEBHE
% 8E  BEETEIRENLIESE - 8% 84 - BUxR - XE5t60 - &2
2Eh ~ HRELIRBEHENA » ROURBIET RSB E » ARRERIFE -

FISSSENMENED » RRTHERBE —LLIRBZRP/ENEIIE
LER  WEREENBEFE—EREnmaL LINEXNRFTIR -



Processing JEfH— S 8l F kel STE0PRR20Y - eH0REL - BH
RIS LR2Y)  (ERs—EOLIRESN LR -

Beta HEEARENHE 1.0 ARAS 2005 & 4 B 20 H&H - O T F 8016 F# -
RIS E R —BHETE » BE 1.0kRIETIS - Processing TS0
Ml + SIEEVEEE Linux ~ Mac 08 X B Windows -

Processing £ — BRI S EET#® - 00 Ben Fry (Broad Institute) &
Casey Reas (UCLA Design | Media Arts) 252 » i Bl'28 MIT Media Lab
(" Aesthetics and Computation Group (14883 H AT -

HHIERFTEhLE LR 0125 BETA
T#EE84: http://processing.org/download/index. html

1-2. Processing DUfRiEEES

Processing 12T, B RE

T W ¢ |

Fik B0 Shexch Took Welp 000

-
=



Processing HliTHRIRE

1-3. Sketch ==

FTE processing FE N —{EM F &R — & sketch B % - &3{E skelch
B IE—{B8H sketch HME=IEEEE R - 167 LE BB P& 4 —{& skelch
T, « Bl EHESEE"Sketch_123" » Bl sketch HiFHiEFLE
"Sketch_123" » [l sketch T2, BiEFLE"Sketch_123.pde" -

sketch IEDNESERER - BE - 85 - TGRSR - ES8IERENE
sketch 5 TaY data"Ei20 -

EMTELGS » A data B8 FOFERE » BT — B
t - {5l "Sketch_123 jar" -

B I » sketch B ZAHEEE® I Processing IZESR T » £
#% sketch ECEEN T HABEREE - O 7 "File"ThEEREE Y
"Preferences"[EEHEEHIE -

B OLEES 522 IS E N ED —(E sketch Bif T - QLIS
Processing [RUSHE  MEEE pde )« LIE Java (RIS (HHERE java ).



1-4. Applet (EH

HRE sketch 2N TLUERBEPINTEVE - A Export DAL » RS
1% Processing [RISHEIBIRT Java [RIBIEIST, - REMmEWN Applet - BF
REBES—LAERNIEE - EE Applet 183 » F3757E sketch BIx Y
applet Bix -

ELNEREEs

index.html : HTML &2 » & applet &—{@ link
Sketch_123.jar : Java Archive

Sketch_123.java : Java [RI51%

Sketch_123.pde : Processing [R151%

loading.gif : 123, T HEB

fEEELE » RRBS data B NOVERZEFIERAR - Rt » EXEHY
JAR [EXRTBEBRAK » B data BIR T » 5 applet FBATOMEE - T
EELRICRER - NECELEBANRRBIRER JAR RO AFENEE
BB > WAL LA JAR B3R\ -

PR : (TiEH Applet 85 - R E1F5tA] applet Bkl - REBBRA
#BY o LLINBIS Applet WL 2 - S7T2EESS 5T Applet 5 » 1202
R ENA BSOS R - N EESIEBEUBISIIN T mIEER » RpcE
IS EIReSEMEE -

1-5. Application (&

ML Processing BIREBIRED » TLIEBLISTEY Java 1I2R05ES
Rtz > (BRRBEUE Applet /5 RIS PHT - WREBBEH
— LRI AKERERERNVEINIANES » BE Applet f£2182500RT
MBERTRM - BRRZEMBIZS  AORIBBRDHT Applet 123, » BEIFZE
AHRERERY - SAIMSBMEZENT -

AL - T2 Applet S Application » FEITIRKR BIEBES - 8815
B R AMEER T2 - R TIE 2 INE BAERIIEE » B8 - 1
TJELEERNO KRR -



Application [EHBYEER :

1. 258 File > Export Application BJTJ

2. PUTERB sketch BIR NEFRBEERR, DBIR application.linux »
application.macosx - application.windows -

3. window B){EFRZE, #N{7 application.windows\ Sketch_123.exe, BJTJRIRX

ESAN

1-6. TEBMUI

1. EiRBIRIBM, 25% Sketch->Present BT
2. AREIVPIALL METER » thiORIEER{T Sketch_123.exe
Sketch_123jar ' LIZEE LT 218 -

static public void main(String args[]) {
PApplet.main(new String[] { "--present", "YourClassName" });

}

1-7. FREERRIR

Processing ¥k Cartesian FMERM - [REEZL LT - BT » x $
IHEmG y @MIEBO T > z EEQRN  BIEOE - ik ARREE R DR -
Rl PIMREEIwidth/2, height/2] - EE—B2HREBG/\E 320
pixels X 240 pixels » GI[0,0/XTREA LA » [320,240|1F5 A -

/ )
Y ./W PN
T[U,D] . [0,0] 4

+Y +Y



RRERCRIR

Processing BY@FIRT DR 2 & » RGB =1 K& HSB 12X o
BRI RCB 21, » BREHIRES N MR -

Il 32 FERBR R:204, G:153, B:0, SEEEEEA 0~ 255
color ¢1 = color(204, 153, 0); // )\ RGB &1 —{EBtEiE

Il EYFEFREARS #FFCCO0, 1M 16 EINBIBRR
color c2 = #FFCCO00; // D\ 16 ENBEUBE Y —BFae8lE
noStroke(); // FRTEFRAELR
fill(c1); // REEWMEED
rect(0, 0, 25, 100);
fill(c2);
rect(25, 0, 25, 100);
color c3 = get(10, 50); /I ESG HEEE(10,50) BNEEE
fill(c3);
rect(50, 0, 50, 100);

RGB &3, Fi2Z Red %I, Green %%, Blue &
HSB 81\, =2 Hue &4, Saturation &E (B3F0E), Brightness ZE

1-9. 127\ 22% (Programming Modes )

Processing BYZTViREBIRT 1 3 & » EAR T (Basic Mode) - EEE T,
(Continuous Mode) D\ K Java EFSIET (Java Mode) - #)88E iS5t E A
BRINRie  BLEVEEEER - 22 OB SAURE - RS BEIEERR K Java
HEERIURTIZD o

1. B

SR ARRBRBETERRBEINNERDE » BENBRNENHY



LERAER L2RK - LT el eEs—BEenRHaes L -

size(200, 200); Il %ES SR/ 200x200
background(255); / RTEERAD

noStroke(); /I8 TESRAELR

fill(255, 204, 0); IERTEBABEER

rect(30, 20, 50, 50); //cEEE[30,20]6%, 2—{& 50x50 NEHFE.

2. EERT

SERTIRH—{E setup( K draw() 2T IFEIR - BN —HBBENT
setup()EIREVEETLHRS - MERBIT—R » —RARFDEDBERIEES
B - HEBRERT draw()BIR BTN - BIME setup() & draw() 2%
Bl » JLIBTHEIARMRERRL - ZRE « 85 - RBRBHA
TBESH -

CITNEHBE 4 88 - mMEEBNS IR ALY circles D5
TURTEA o circles T IT-RE Processing AHIRIEEVINAEE - MBELIZD
PRIMRFRI LEIN - £ draw()BIRPVENBR BN T—R KRBT setup()
BB » EXE S noLoop() * MBABREH(T -

void setup(X
size(200, 200);
noStroke();
background(255);
fill(0, 102, 153, 204);
smooth(); noLoop();

}

void draw(){
circles(40, 80);
circles(90, 70);

}

void circles(int x, inty) {
ellipse(x, y, 50, 50);
ellipse(x+20, y+20, 60, 60);



}

A NESBEHRFHIBKIBRBENUBRERDE - BROVBRIZERGEERREE
(mouseX and mouseY)d - 7 draw()BIRD » 2B FEMIIT - IS
RIBEERE) » BEETRDPIL - LLERHTMUELRER O BRIME -

void setup(){
size(200, 200);
rectMode(CENTER);
noStroke();
fill(0, 102, 153, 204);
}
void draw(){
background(255);
rect(width-mouseX, height-mouseY, 50, 50);
rect(mouseX, mouseY, 50, 50);

}

3. Java ¥fBET

SERIE—(BEa®EMEVET, » LI Processing fREERIED » Bi%
D5 Java 2T FBERFERZT, - TUHEDRD » QLUEEORR ERE
ZBR1S Processing ATIRIEBIETE » MR ILUEHETE Java 55S12HVE
IVE o

public class MyDemo extends PApplet {
void setup() {
size(200, 200);
rectMode(CENTER);
noStroke();
fill(0, 102, 153, 204);
}

void draw() {
background(255);
rect(width-mouseX, height-mouseY, 50, 50);
rect(mouseX, mouseY, 50, 50);

}



1-10. FRESET, (Rendering Modes )

Processing IRIAVERESLBRINELAT 3 & £—2 A Java 2D 186
12108 ETE AL P3D 89 3D 1885 1% » $5=8%58 JOGL 3kEE
OpenGL i\@}%E o FIRBREF B — BB KW B R » TR size()
BRI TE - B85 —12EIRE » Processing {8 TRZE N » EEFNINFIRE
Ia‘éﬁ%ﬁ%@ﬂ BREENERE—LER -

1. JAVA2D

AR Java 2D @82\ ERAES: 2D %ﬁf% SRIESNTFRELRT - YR
RERANRE MBLLEERIEL

size(200, 200);
background(255);
noStroke();

fill(255, 204, 0);
rect(30, 20, 140, 160);

A N eE IR BRENER E 21 Java 2D FARES ST
size(200, 200, JAVA2D);

background(255);

noStroke();fill(255, 204, 0);

rect(30, 20, 140, 160);

2. P3D

BB G R REREE! 3D £, i 2D &7
size(200, 200, P3D);

background(0);

noStroke();fill(204, 204);
translate(width/2, height/2);
rotateX(Pl/6);



rotateY(PI/3);
rect(-60, -60, 120, 120);

3. OPENGL

SERTEREIRBEMS R OpenGL BIEIRRBYER » ILUDRER
NEE - R ERREBREIEBELUREAETHENSS -

Processing 5%;8 JOGL 3RER OpenGL NEEE » Hd JOGL 243 SUN
BB RN/ HEATSS R - ALY, - BBAEER - 2H 7% OpenGL BN
BE 0 ATUFRD 3E JOGL FriZiEaiE s EmIIHAL -

KRR ELRR - AR SRAEABE < Ak OpenGL Zif
BV MEMAE -

EATNCASER OPENGL g E S R 508ER)
import processing.opengl.”;

void setup() {
size(800, 600, OPENGL);
noStroke();

}

void draw() {

float x = mouseX - width/2;

background(255);

fill(0, 102, 153, 26);

for(int i=0; i<height; i+=10) {

for(int j=0; j<width; j+=10) {

beginShape(QUADS);
vertex(x+j, |, 0);
vertex(x+j, i+5,  0);
vertex(j-x, i+5, -400);
vertex(j-x, i, -400);
endShape();

10



1-11. EA TSR

1. BRI ETH#E Statements and Comments

Statements RIZTVIROVEAITER  LIDRIFR Statement gY#5R o
Comments SEEERIERIRINERIBLRBIL - NBANAE ™ ™ RBEEt
BREINS ERK

A N2 —1{Esehl
/Il Statements and Comments
/I by REAS <http://reas.com>

[
The size function is a statement that tells the computer

how large to make the window.

Each function statement has zero or more parameters.
Parameters are data passed into the function

and used as values for specifying what the computer will do.
wx

size(200, 200);

Il The background function is a statement that tells the computer
// which color to make the background of the window
background(102);

2. FAEER{E A Coordinates

BB 2RRNEHER - LERTEEIEREXIMIBIT @ SEREERE
[RE0 EIBVEREE > DA pixel fRE(] - HPIRES [0.01RFIRBNAL LS » S
THHEEESR [width-1, height-1] » width & height £i8ZHERE -

11



/I Coordinates
/I by REAS <http://reas.com>

I/ Sets the screen to be 200, 200, so the width of the window is 200 pixels
// and the height of the window is 200 pixels

size(200, 200);

background(0);

noFill();

stroke(255);

// The two parameters of the point() method each specify coordinates.
// This call to point() draws at the position [100, 100]
point(width/2, height/2); /14825

// Draws to the position [100, 50]
point(width/2, height/4);

/Il It is also possible to specify a point with any parameter,
// but only coordinates on the screen are visible

point(60, 30);

point(60, 134);

point(160, 50);

point(280, -800);

point(201, 100);

Il Coordinates are used for drawing all shapes, not just points.

/I Parameters for different methods are used for different purposes.

/I For example, the first two parameters to line() specify the coordinates of
the

/1 first point and the second two parameters specify the second point
stroke(204);, /I FRTENEARERED

line(0, 73, width, 73); // BB

Il The first two parameters to rect() are coordinates
/Il and the second two are the width and height
rect(110, 55, 40, 36); /{84 %61

ellipse(56, 46, 55, 55); /@LHEEF

12



3. §ET M E ] Width and Height

27 size( YR M T ASNERER « SITLIFUE width' & height
S 2 ERYKES ERENNET -

I Width and Height
I by REAS =http:/ireas.com>

size(200, 200),
background(127);
noStroke();
for(int i=0; i<height; i+=20) {
fill{0);
rect(0, i, width, 10);
fill{255);
rect(i, 0, 10, height);
}

I3



1-12. HERSREIUAGHS

1. B Recursion ( ERITIUEHRS, )

LU T ey AR F RS IR ISR D I AE R R DA R « 8K 1 Baa
ERR - BRI - SEXRREENER - REZEEIER -

LIT R0 ER 20 level /12 1 FRLECED -

Il Recursion
Il by REAS <hitp:/freas.com=>

void setup() {
size(200, 200);
nostroke();
smooth();
nolLoop();

}

void draw() {
drawCircle{126, 170, 8);

}

void drawCircle(int x, int radius, int level) {

4



float tt = 126 * level/4.0;

fill(tt);

ellipse(x, 100, radius®2, radius*2);

if(level > 1) {
level = level - 1;
drawCircle(x - radius/2, radius/2, level);
drawCircle(x + radius/2, radius/2, level);

}

H

BT B R — Bl s s

il Recursion
i by REAS <hitp:fireas.com=>

void setup() {
size(200, 200);
noStroke();
smoaoth();
drawCircle(100, 100, 80, 8);

)

void drawCircle(float x, float y, int radius, int level) {



float tt = 126 * level/6.0;
fillitt, 153);
ellipse(x, v, radius*2, radius*2);
if(level = 1) {
level = level - 1,
int num = int{random(2. 8));
for{int i=0; i<num; i++) {
float a = random(0, TWO _PI);
float nx = x + cos{a) * 6.0 * level;
float ny = y + sin(a) * 6.0 * level;
drawCircle(nx, ny, radius/2, level);

2. {EEFHYI¥F Objects

Her o2 T R ey ] 5 AR S - .-'.I S g ST gy b i T e (o e L » S = ey e
LR IE = S e SRt » fOR -”ﬁ:f: UEe SRR OETD TR
— G — 8§ SR hE B I+ AR FHEOUYMHE-EER R - FLOLEE —{5

YA S RSN R RRE -

il Objects
i By hbarragan

MREect r1, r2, r3, rd;



void setup() {
size(200, 200);
fill(255);
noStroke();
r1 = new MRect(1, 134.0, 0.532, 0.083*height, 10.0, 60.0);
r2 = new MRect(2, 44.0, 0.166, 0.332*height, 5.0, 50.0);
r3 = new MRect(2, 58.0, 0.332, 0.4482*height, 10.0, 35.0);
r4 = new MRect(1, 120.0, 0.0498, 0.913*height, 15.0, 60.0);

void draw() {
background(0);

r1.display();
r2.display();
r3.display();
r4.display();

r1.moveToX(mouseX-(width/2), 30);
r2.moveToX((mouseX+(width*0.05))%width, 20):
r3.moveToX(mouseX/4, 40);
r4.moveToX(mouseX-(width/2), 50);

ri.moveToY(mouseY+(height*0.1), 30);
r2.moveToY(mouseY+(height*0.025), 20):;
r3.moveToY(mouseY-(height*0.025), 40);
r4.moveToY((height-mouseY), 50);

class MRect {
int w; // single bar width
float xpos; // rect xposition
float h; // rect height
float ypos ; // rect yposition
float d; // single bar distance
float t; // number of bars
float side; // rect width

17



MRect(int iw, float ixp, float ih, float iyp, float id, float it) {
W= iw;
Xpos = ixp;
h =ih;
ypos = iyp;
d=id,
t=it;
}

void moveToY (float posY, float damping) {
float dif = ypos - posY;
if (abs(dif) > 1) {
ypos -= dif/damping;
}
}

void moveToX (float posX, float damping) {
float dif = xpos - posX;
if (abs(dif) > 1) {
xpos -= dif/damping;
}
}

void display() {
for (inti=0; i<t; i++) {
rect(xpos+(i*d*w), ypos, w, height*h);
}
}
}

18



1-13. #23/E (Processing API )

http://processing.org/reference/index ext.html

Processing [RIEFZIETNE, 165, BEMRXMIOURSBRAVESNSEE
IR
ENHRHENERNBEORU TEBEALER, DRYSRD, FETLERLH
RE3. RIBETHTENER, RVIENENERST.

Structure 12T\ 1518
Environment 2 HTB1E

Data X

Data — Primitive EARIR|

Data — Composite &£5HYR|
Data — Conversion AUB|§Eik
Data - String Functions 25218
Data - Array Functions of&ERzI8

Control 225

Control - Relational Operators | EREIHEE
Control - lteration @&

Control — Conditionals &%

Control - Logical Operators {§{4EHRES

Shape BE

Shape - 2D Primitives 2D EAJE
Shape — Curves ghi®

Shape - 3D Primitives 3D A
Shape — Attributes BE &t
Shape — Vertex B2

Input A

Input — Mouse B8
Input — Keyboard #2#g
Input — Files 123
Input — Web #3ii5

19



Input - Time & Date B, OHA
Output &

Output - Text Area BT
Output —-Image EZ32

Output —Files FEZ1E%

Transform 3D &2

Lights, Camera ¥¢B, 1RA

Lights, Camera — Lights Y4B

Lights, Camera — Camera 83

Lights, Camera — Coordinates [F&Z
Lights, Camera - Material Properties #4125

Color Z868
Color — Setting %7
Color - Creating & Reading E17, &

Image /&
Image - Loading & Displaying & A, &/
Image — Pixels %

Rendering B 218

Typography %

Typography - Loading & Displaying & A, F&/n
Typography — Attributes B/

Typography — Metrics ¥j75

Math 2723

Math — Operators EAE&

Math - Bitwise Operators {\[758&

Math — Calculation 5t&

Math — Trigonometry —@BK &

Math — Random BEREKEN

Constants £

20



1-14. TR

1. FH2ET,

http-/fprocessing.orgflearning/index. html

FEERLEMEL - BESEELN TR ERRERER B0k
% SRS RO - OLIEEE CAENIESRE  ORthaOLIGEATHR
HENEREEE  TERERISTOERLT, - WEAREET REIBCHETS
o

Hiie Mg « 457 : Basics - Topics - 3D & OpenGL - Libraries
% o

2, Processing 238

HYNERIE S8 EE HAR Processing HERSUEFS » ] -

Processing: A Programming Handbook for Visual Designers and
Artists.
Casey Reas and Ben Fry. Published 24 August 2007 by MIT Press. 736

pages.

21



0D '

Processing

=

Processing: Creative Coding and Computational Art.
Ira Greenberg. Published 28 May 2007 by Friends of Ed. 840 pages.

Ld ot Py
— - T -
L

Built with Processing (Japanese).
Published 28 March 2007 by BNN.



58 _—E ~ Processing 23\ Bl#nfg %2 g&

[ Webcam EBZIEEEBINE 1 TIFL5

A

2-1. FiEEERA
2-2. FIEENER
2-3. EEBH
24. BRLH

2-1. PIFEREE

1. Basic

* Java SDK

(JDK 6u2), http://java.sun.com/javase/downloads/index.jsp
(jdk-6u2-windows-i586-p.exe)

(JDK 5.0 Update 12),
http://java.sun.com/javase/downloads/index_jdk5.jsp

(jdk-1_5 0_12-windows-i586-p.exe)
* Processing (0125),

http://www.processing.org/download/processing-0125-expert.zip
(processing-0125-expert.zip)

* Demo Program, (Sound *1, Webcam *2, Wii *1)

23



2. For Microphone Sound

* Sound Lib : Minim(1.1),
http://code.compartmental.net/minim/distro/minim-1.1-lib.zip
(minim-1.1-lib.zip)

3. For Webcam Vision

*Vision Lib : BlobDetection,
http://www.v3ga.net/processing/BlobDetection/Resources/9/
(blobDetection.jar)

*QuickTime (7.2), http://www.apple.com/quicktime/download/
(QuickTimelnstaller.exe)

*WinVDIG, (104) http://www.vdig.com/WinVDIG/WinVDIG 104.exe
(WinVDIG_101.exe, WinVDIG_104.exe)

*Webcam Driver : Logitech,
http://www.logitech.com/index.cfm/support downloads/downloads/&cl=tw.z
h

QuickCam® Messenger (qc1100.exe)
QuickCam® IM™ (qc1100.exe)

QuickCam® for Notebooks Pro (qc848cht.exe)

24



4. For Wii Remote

*Wii Lib :

WiiRemoteJ(1.0)
http://www.world-of-cha0s.hostrocket.com/WiiRemoteJ/ (WiiRemoteJ
v1.0.zip.gz)

*BlueTooth Lib :
avetanaBluetooth
http://www.avetana-gmbh.de/avetana-gmbh/produkte/bestellung.eng.xml

*BlueTooth Driver :

MSI, (Star Key 2.0 (3X Faster)) (WIDCOMM Bluetooth Dongle Driver)
http://taiwan.msi.com.tw/index.php?func=downloaddetail&type=driver&mai
ncat no=131&prod no=101 (StarKey 4.0.1.2900.zip)

© Bluetooth

L

USB Adapter

2-2. PsteRe

1. Webcam+Microphone :

Logitech §&%; IREBFAZX QuickCam Messenger (RNERZE/EA)
http://shopping.pchome.com.tw/?mod=item&func=exhibit&IT NO=ABAL18
-A03124781&SR NO=ABAN1P&ROWNOQO=6

2. BlueTooth Adapter EZFZINES

25



MS| 75 Star Key 2.0

hitp:/Maiwan.msi.com.tw/index.php ?func=downloaddetail&type=driver&mai
ncat no=131&prod no=101

3. Wii Remote :
Wil EFEE% http://buy.yahoo com tw/gdsale/gdsale. asp?qdid=489988

2-3. Blmss™

1. PECAEMINEA TR
2. Webcam+Microphone ( #1515 Webcam 81#7E )
3. BlueTooth Adapter 25 1# 1122 (Star Key 2.0)
( ps. U E(ERMENESFEIIE (StarKey 2.0)» ~EHFEMNEN - H
B AE PN EESF BT Processing B5 - )
4. Wii Remote #3235

2-4. ZEGER

*!Ba!iﬂ e o
1. Java SDK {JDK 6u2)

B 57 jdk-Bu2-windows-i586-p.exe.

SOTFINT

o e b e e e T T

RUPEN  Custom Setup g
- -“' Select ihe program Raatires you want retaled "& ”l'?}

Sebrct cpmonal Feallres to ratal Fom B BT Delow, Yol can chargs vour choice of faah res afer
reskalabon by wmng the AddFemove Programs Uity in the Control Pand

Featne Detorpasn

e T Sz SE Devkpmert
= | Do and Sampies x g

y i & Upcdate 2. This wil requirne !

| Source WP ir yr e e |

| Pubic RE '

| wa e '

|

|

Brostad b I

CAPTagram Fles deeatgd L6 O 03 L Chareges,, | l

| <Bak | pear || cemed |
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W ETE path BEfE : [FAVSEE]>[PS]> CERS] > [ERR ] > R sa] -
Bhi%E Path, 17 T[#RiE], £RHENSHEEE A C\Program
Files\Java\jdk1.6.0_02\bin\ EIE] -




2. Processing (0125)

B 51% processing-0125-expert.zip [FEHE T C\ &S T CAEET
‘HIF processing-0125-expert E3 -

B #i7 C\ processing-0125-expert\ processing.exe, &0 IEF [FEEE T
TR -

@ Processing <0124 Bera O _Jokd
File Edit Sketch Tools Help

skelch_070710a

B 2E L{FEiR, & C\ B FHhiE—EEHR artwork,

B 55 processing, %538 File-> Preferences #1001, 4 Preferences ¥55iE
o, EHE Sketchbook location & C:\ artwork.



SINE 4 L

] i

Sketch Tools H
Mew Ctrl+N
Sketchbook
Save Ctrl48 o
Save As... Cul+shiftes |
Export Cirl+E
Export Application Ctrl+5hift+E
Page Setup Ctrl+Shifi+P
Frint Ctrl+F

| Bisferences |1 Cith |

Quit Cirl+Q

[0] s mitiple e fies when exporting pplets

[CJrampt for riame when opering or cresting a skelch

[2] Detete ety shetches on ut-
Sketchbook location PSSRy
[Swtwa -~ S e | [ erowse |

Ecior font size. 12 (requires restart of Processing)
I

[+] St maiemum available memary o WE

[ Use externl editce

[] cresck for updates an starup

Mare praferences can be sdied drecty in the fie
C \Documents and Seltingsszcnibppication DataProcessingpreferences b

(el oriy when Processing i nol renning)




3. Demo Program

W & demo.zip (R EET C:\ artwork » R & & 7F C\artwork 5§ T 1H
I demo EF§35k

B 7R processing {#, it File-> Sketchbook #E T » @& T demo &
Examples [LE -

B2 Processing - 0124 Bera ' ___#L_.,__I”!
F Edit Sketch Tools Help S i) ks |
MNew Ctrl+N
| sketchbook 9 Ry
i Save Ctrl+2 . .r_ir-_r;'nu -
| Save As... Ctrl+5hif1+5 sketch 0707104
! Expor Ctel+E Examples b
! Export Application Ctril+Shift+E T s
Fage Setup Cel+5hift+p !
Frin Cul+P
Preferences Ctrl+,
it Cul+Q
"
< 2

** For Webcam Vision ***

1. Vizion Lib : BlobDetection



B ;5 blobDetection ERAEREF! C:\ processing-0125-expert\libraries
Bix b o

2. Webcam Driver : Logitech,

B Z webcam FBENZT

W 55024 webcam, BEIZEEZTRTRBEA
B QuickCam® Messenger (qc1100.exe)

B QuickCam® IM™ (qc1100.exe)

B QuickCam® for Notebooks Pro (qc848cht.exe)

3. QuickTime (7.2),

B ZZE QuickTimelnstaller.exe

4. WinVDIG, (101)

M %t WinVDIG_101.exe

W TR ERTRIE->12T E->WinVDIG->QTCap » ETUEF webcam &/
B MRNZERD -

B R{IREBERN

** For Microphone Sound ***

Sound Lib : Minim(1.1)
B FER minim ERIRERE| C:\ processing-0125-expert\ibraries 8§ T

W HTTEER
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** For Wii Remote ***
1. Wii Lib : WiiRemoteJ(1.0)

B 58 WiiRemoted BRIERIF! C:\ processing-0125-expert\libraries &
N

2. BlueTooth Driver : MSI, (Star Key 2.0 (3X Faster)) (WIDCOMM
Bluetooth Dongle Driver) )

B BN 2IEAETBNES BYRERTIRTEHEEA -
B % Star Key Se2HI2T, - BT StarKey 4.0.1.2900 Big = setup.exe
WERE > Fro NEESZETR L EEOR  BIZ NESERERTE . &

MigEe , MIEE TN BEROSTHREF BNEESE » W TEBE » K
g0 : 00:02:72:cc:18:73
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6@ MSI Star Key USB Bluetoth Device

EEAT -
&SRB - HEAEE FTEEE -
BER: Brosdcom Corporation
PaRT Version 820265/ 39
&EEH - 00:02:72:CC:18:73
HCIREAR ¢ Bluetooth HCI 20
HCI %87 : 2004
LMP B ¢ Bluetooth LMP 2.0
LMP :RER A ¢ 4127

(Cwe [ =8 ] =Aw

B SHRNARNER  FRESRNSREBEBA e T "&%RE
BIg -

B BlueTooth Lib : avetanaBluetooth, :58&%
http://www.avetana-gmbh.de/avetana-gmbh/produkte/bestellung.eng.xml

B GIAEARER, email, EFENDEBNBSERERE, 17 submit 3R,
T = BT-Address Y&V 00-02-72-cc-18-73

G0N
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Narne jason

Firstname ?lée )
Company *aaa

Street Q;taipei g
PO Box City .%100 2 e B

Phone los00000123 ' ]

Your download-link will be sent to this address. Please do not enter a dummy address.

E-Mail jasnn|ee’>357@gvga netiw

Notity me of updates in avetanaBluetooth

Please make sure {0 enter at least one valid Blustooth-Adress, that you want to use this fibrary on (e.g. 00-0d.93-05-17-0e)
BT-Address 1 [00-02-72-cc18-73 |

BT-Address 2 ;

BT-Address 3

W C&EE— FEcH email, EEENEI—11Es| MERHNE, HIRER,
BRIBE, & Mthislink. ;, N&#2T\ & avetanaBluetooth jar, FEGZE
C:\ processing-0125-expert\libraries\WiiRemoteJ\library . &g

To download your library, please click {Save Link target as...) this link.

The license will be valid untit 23.07.2007.
The licens is right now valid for the foliowing Bluetooth Addresses:

You must erter at least one Bluetooth-Address for which the kcense shall be valid (e.g. 00-0d-93-05-17-02)

Bluetooth-Address 1 (00-02-72.cc-18.73 |
Bluetooth-Address 2 [o0-02.72.cc18.73 |
Bluetooth-Address 3 00-02-72cc1873

To change the Addresses for which the library shall be valid, pleaee enter the new addressges in this form and submit
the product has not been purchased.

B HATTEREN ) ANTENRECETES RS ED@%?’ SEFENBH
IRPOMEEIEHS » 2 ™ Wii Remote & 5BVAI Ei%iH » TISRBETEIR, 53
Wii Remote BY 4 {BPT/4 SIS T — (BEEIE Y, EJBE@%&E}ZDJ cBEA LB
RS TEMROVENT - BER—EREABPHECEAN TEIROVEME » BiR—
N Wii Remote & 5BIAI@21%H » IOLISEHRER S < SEEHREE - ®
REREBITENROVENME » F—REWITEIR - siBEAE] Wii Remote -
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58 =% ~ Processing 123, {5< BA&i HIZRER

[Webcam ERZIRBEAIVE ] T1EH

N
3-1. Processing EA1ES
3-2. Processing #3{5:205

ANRBVIZTV &8, T processing FTIZIEHIZTN BT, ARHERD, &
SR IBERIRESSD, BREDN2HIE, WA, DITHRY
BB R2IRNFE, BT FENENERBEHE.

3-1. Processing EA{SS

1. Color 2868

background(0); // ERTEESEED
background(255);

background(255, 204, 0);
stroke(255);  /GXTERRIFERE
stroke(0);

stroke(255, 204, 0);

fill(0, 102, 153); /[FRTEIEMEEED

2. Shape iR

point(30, 20); I %6

line(0, 20, 80, 20);  // £4x, £3(0,20) =7 (80,20)

rect(10, 20, 30, 40); // %6, 1(10,20)%, =—EE 30 5 40 3456
o

ellipse(56, 46, 55, 80);, EEE, 7£(56,46)i%, =—EEBEX 55 58
£ 80 NEE
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3. Image

set(30, 20, 255); // SR}ESERFAE(30,20)5928 4 R:30, G:20, B:255
a=get(60, 10); // BUSEIREIE(60,10)808860 » IISTER a B8] -

pixels[y*width+x]

Il BUSS/IREER(x, V)BUEAE » BB —{ERY width x height B8 E
Kl - 7 processing PR pixels BY—#fEp, SIS ERALES
FER(x, Y)TE pixels fBYICOEITE » KA y*width+x ZRSH) » M
pixels[y*width+X]Rl 2 R EER(X, V)BVEED

4. &N

intx =70; // Initialize /IS —ERRSE x, WETEBSRE x HIER
70

x = 30; // Change value // s2EREUE x BYBR 30

floatx =70.0; /| BEE—EFEHEEE x, WRTESIHEES x NER
70.0

x=30.0; // SEEFFHERE xER 30.0

intfla={5,10, 11},  // @&Y[—{@FED| a> WeREFEDTTERE 5, 10, 110
a[0] = 12; // Reassign /I 357EfBEY a NE 0 BIcE=R 12

5. Control 12l

EIRRHREBAT
void draw() {
Il Statements  REFTIHEINERCETI

}

BIRRERENT
for(int a=45; a<=55; a++) {

/I Statements R BRI TUIZIERCIZ TN, B3 a=45 B{TF) a=55,
FIT—R aghiii1,

/I a++ {£FF a=a+1;
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BIRERT
if(c==1) {
Il Statements, & ¢ FR 165, FTHENREZEDNG

}
if(cl=1) {
/I Statements, & ¢ AFR 105, ATHRENREDIE
}
if(c < 1) {
Il Statements, & c /IR 165, TIIRTER2IZTIE
}
if(c >= 1) {
/I Statements, & ¢ KIRXFR 1585, PTHEDNER RN
}

if((c >= 1) && (¢ < 20)) {

I Statements, & c KIRTFIR 1 LIK c/\iR2085, RITLIRTER
R ESAN
}

if(c >= 20) {

/] Statements 1, & ¢ KIRTAFR 20 55, BITHIZTER212T %
}elseif (c==0){

Il Statements 2, BRI ¢ FR 065, ATIHEZTRER22NIE
}else {

Il Statements 3, SRIFTIIZTROIZTNIS
}

6. Input/Output & A/&H

mouseX HUSBE x BiZ
mousey HUSBR Yy BiE
mousePressed EUSBRESIZ FoiREe

void mousePressed() {
/l Statements  EBRIZ N, BITHERBRoR2RIE
}
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IFETRERFIT a

(key=="a’) EVSEREZZ N EUB,
B WHETRERTITD

(key=="0") ENfG#AZIZ N8B,

SESS

void keyPressed() {
Il Statements Eigi&iz My, WTIIETERCEDIR

hour() BEVSERNIFEC/)\FEUB
minute() EVSERIFEC DESE
second() BVSERINECWEEIEB

3-2. Processing £i/55785

1. Statements and Comments

Statements are the elements that make up programs. The ";"
(semi-colon) symbol is used to end statements. It is called the
“statement terminator." Comments are used for making notes to help
people better understand programs. A comment begins with two
forward slashes ("/I").

Statements R\, ZTIEEERERNEARITE " (semi-colon) 5
e FARIE R — Bl 2TV IBEVAS RTS8 - Comments E18R £
HERIZTITIN0BYER0T - BENRIBRIZIEAI/ER » slashes (/") &
R RIR T SR BN T RETERRIEY S -

/I The size function is a statement that tells the computer
/I how large to make the window.

/I Each function statement has zero or more parameters.
// Parameters are data passed into the function

/'and used as values for specifying what the computer will do.
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size(200, 200);

/I The background function is a statement that tells the computer
/1 which color to make the background of the window
background(102);

2. Coordinates

All shapes drawn to the screen have a position that is specified as a
coordinate. All coordinates are measured as the distance from the
origin in units of pixels. The origin [0, 0] is the coordinate is in the upper
left of the window and the coordinate in the lower right is [width-1,
height-1].

PrEBENEFBROER ERIBR, TLREBHRNIE, BY
BRI RE, B &S, BIENENRBZR(pixel), BEBRBIHHIRE
BR, 72 £/(0,0) &5 T E(width-1, height-1)

/I Sets the screen to be 200, 200, so the width of the window is 200
pixels

// and the height of the window is 200 pixels

size(200, 200); /I EEEHAN

background(0); // S¥EEREED

noFill(); Il REHEIEW
stroke(255); Il 32 TERRIFFEE

/I The two parameters of the point() method each specify coordinates.
/1 This call to point() draws at the position [100, 100]
point(width/2, height/2); /| 2%}

// Draws to the position [100, 50]
point(width/2, height/4); /| £%4

Il 1t is also possible to specify a point with any parameter,
// but only coordinates on the screen are visible

point(60, 30); // E=E;

point(60, 134);
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paint{160, 50);
point{280, -800);
point(201, 100);

if Coordinates are used for drawing all shapes, not just points.

/f Parameters for different methods are used for different purposes

Il For example, the first two parameters to line() specify the coordinates
of the

i first point and the second two parameters specify the second point
stroke(204); /R TEEREED

line(0, 73, width, 73); N Mg

/f The first two parameters to rect() are coordinates
il and the second two are the width and height
rect(110, 55, 40, 36); /f WHEHRE

3. Width and Height

The ‘width' and 'height’ variables contain the width and height of the
display window as defined in the size() function.

T(width) & F(height) » (FZRETIRENEES » ¥I/H size(200, 200)
R ERERRE -

size{200, 200},
background{127};
noStroke(];
for{int i=0; i<height; i+=20) {
fill{0);
rect{0, i, width, 10},

i



fill(255);
rect(i, 0, 10, height);

4. Setup and Draw

The draw() function creates a structure in which to write programs that
change with time.

1£ setup()BUIZTER TP » RBET—K » —MRAIRIERDIGIRRERIERE - 1E
draw()BVEIERD  BRENT M-

/l The statements in the setup() function
I/l execute once when the program begins
void setup() {
size(200, 200); // Size should be the first statement

stroke(255), 1/ Set line drawing color to white
frameRate(30); // EX7E draw()IRINER » SMTHOHRZES
}
floaty = 100;

/l The statements in draw() are executed until the
I/ program is stopped. Each statement is executed in
/l sequence and after the last line is read, the first
/ line is executed again.
void draw() {
background(0); // Set the background to black
y=y-1
if (y<0){y=height; }
line(0, y, width, y);

5. No Loop
The noLoop() function causes draw() to only execute once. Without
calling noLoop(), draw() executed continually.
noLoop()1ERBIF draw(IZTLER R T—R » NEE draw() 2R H
RERIT A -
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/I The statements in the setup() function

I/ execute once when the program begins

void setup() {
size(200, 200); // Size should be the first statement
stroke(255); // Set line drawing color to white
frameRate(30);

noLoop();

floaty = 100;

/l The statements in draw() are executed until the
I/l program is stopped. Each statement is executed in
/I sequence and after the last line is read, the first
// line is executed again.
void draw() {
background(0); // Set the background to black
y=y-1
if (y <0){y = height; }
line(0, y, width, y);

6. Loop

The loop() function causes draw() to execute continuously. If noLoop is
called in setup() the draw() is only executed once. In this example click
the mouse to execute loop(), which will cause the draw() the execute
continuously.

loop()IETBIE draw(IZTVERFHIBIR BT T ©

/I The statements in the setup() function

/I execute once when the program begins

void setup() {
size(200, 200); // Size should be the first statement
stroke(255); /I Set stroke color to white

nolLoop();
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floaty = 100;

// The statements in draw() are run until the
// program is stopped. Each statement is run in
// sequence and after the last line is read, the first
// line is run again.
void draw() {
background(0);  // Set the background to black
line(0, y, width, y);

y=y-1
if (y < 0){
y = height;

void mousePressed() {

loop(); /1 EBEETE > BT loop()iEF @ {215 draw(IZTURBEBRERT
F o
}

7. Re-draw

The redraw() function makes draw() execute once. In this example,
draw() is executed once every time the mouse is clicked.

redraw()i§ S B1E draw(ies\ERBH{T—R -

/I The statements in the setup() function

/l execute once when the program begins

void setup() {
size(200, 200); // Size should be the first statement
stroke(255); // Set line drawing color to white

nolL.oop();

float y = 100;

/f The statements in draw() are executed until the
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! program is stopped. Each statement is executed in
I saquence and after the last line iz read, the first
iine is executed again.
virkd dranwt) |
background(D), N Set the background to black
¥=y-1;
i iy < 0){y = height, }
leines(0, v, wWidlh, v}

void mousePressed() {
redrawl);, # SPEERERTI BT redraw (155 B8 draw( )2 EEST—F -

8. Functions

The draw_target() function makes it easy to draw many distinct targets.
Each call to draw_target() specifies the position, size, and number of
rings for each target.

Function Z2{5BE] ETRE# » OLIGHEEEEBRERTIEHETER « LA
SE]NETHEHEG - BRAEENERAZIL B EBsaEHaHEL ¢
BRI ETEHIEOERH R - £8P - BE]ET draw_target()H
FEH—EELENERE - ERAZEE intxloc (Bl x HEER), int yloc
(B y HEEE), int size(B)(LEIELE), int num(E)ILEEE) - void (1]REH
fHOE -

void setup() {
size(200, 200);
background(51};
naStroke();

o



smooth();

noLoop();

void draw() {

draw_target(68, 34, 200, 10); // 7EEEIE(68,34)Ri8H — BB 200 » BEA 1089
BLE -

draw_target(152, 16, 100, 3);

draw_target(100, 144, 80, 5),

void draw_target(int xloc, int yloc, int size, int num) {
float grayvalues = 255/num;  // {KBEEILEBH @ stEZ—BILBESERZE
iz2i
float steps = size/num; /| KIREINEBE - StEZ—BILENBTEE
for(int i=0; i<num,; i++) {
filli*grayvalues); // SXEEFEBVERBIKIEE
ellipse(xloc, yloc, size-i*steps, size-i*steps); // FEEIZE(xloc, yloc)@EHB XK
size-i*steps NEFE
}

9. Recursion

A demonstration of recursion, which means functions call themselves.
Notice how the drawCircle() function calls itself at the end of its block. It
continues to do this until the variable "level" is equal to 1.

AT ERsREE B8BTS W AEETSHEREN—I&ET0E
BISIE @ BRISER » FRCBISIEFORERE » WITNEM
HEEONBE - &Pl » IKEHBERBEEE  ENEPXBLIE
TH— » ERSE MR KA » BE level B/\VIRFJR 18712
IFEE - R HIRNEBERE — @ NEie/ ) \ B2 IRUR -B5]155 drawCircle
OFRZRELER - ERIAZERE int x(BILEER), int radius(BfE41E), int
level GEBRSE)
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void setup() {
size(200, 200);
noStroke();
smooth();
noLoop();

}

void draw() {

drawCircle(126, 170, 6); N {EHE x 575 126 (& - BHPE 170 00 -
PE3I 6 -
}

void drawCircle(int x, int radius, int level) {
float tt = 126 * levelld 0,  / EtRIEMEREOEES
fill(tt):
ellipse(x, 100, radius*2, radius*2); / 7EFEE(x, 100) BHELS
radius*2 ME -
if(level = 1) {
level = level - 1;
drawCircle(x - radius/2, radius/2, level);
drawCircle(x + radius/2, radius/2, level);
}
}
H—{EEInEEH
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void setup() {
size(200, 200),
noStroke();
smooth();
drawCircle(100, 100, 80, 8);

void drawCircle(float x, float y, int radius, int level) {
float tt = 126 * level/6.0;
fill(tt, 153);
ellipse(x, y, radius*2, radius*2);
if(level > 1) {
level = level - 1,
int num = int(random(2, 8)); // £ 2R 62  BS—(Eiat&El
=
for(int i=0; i<num; i++) {
float a = random(0, TWO_PI); // £ 01 TWO_PI 2 » BiE—
[EfEHES
float nx = x + cos(a) * 6.0 * level;, // STEHH) nx R
float ny =y + sin(a) * 6.0 * level; // ST8%78Y n FEE
drawCircle(nx, ny, radius/2, level); // 2 ~N—EEF

10. Create Graphics

The createGraphics() function creates an object from the PGraphics
class (PGraphics is the main graphics and rendering context for
Processing). The beginDraw() method is necessary to prepare for
drawing and endDraw() is necessary to finish. Use this class if you
need to draw into an off-screen graphics buffer or to maintain two
contexts with different properties.
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fiJFH createGraphics(){5 + i 1[—{@ PGraphics ¥,
PGraphics pa;
void setup() {

size(200, 200);

pg = createGraphics(B0, 80, P3D); / BT —EEEYE pg
}

void draw() {

fill(0, 12); i NIAE 24
rect(0, 0, width, height); / BESEZFUE
fill{255);

noStroke();

ellipse{mouseX, mouseY, 60, 60);, # BH—EEILE

pg.beginDraw(); I BIERTETE PGraphics HVEETE
pg-background(102);

pg.noFill();

pg.stroke(255);

pg.ellipse{mouseX-60, mouseY-60, 60, 60),  MH—EZ0E

pg.endDraw();

image(pg, 60, 80); // ¥ pg S I A,
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2 PUE ~ Java ME 23 E5RAA

[ Mobile ERZIRREBIIE 1 TIFID

Java ME &

4-1. Java ME Platform CLDC Specification

Java Platform, Micro Edition (Java ME) provides a robust, flexible
environment for applications running on mobile and other embedded
devices—mobile phones, personal digital assistants (PDAs), TV set-top
boxes, and printers.

Java ME includes flexible user interfaces, robust security, built-in network
protocols, and support for networked and offline applications that can be
downloaded dynamically.

Applications based on Java ME are portable across many devices, yet
leverage each device's native capabilities.
hitp://java.sun.com/javame/index.jsp
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4-2. Sun Java Wireless Toolkit for CLDC

The Sun Java Wireless Toolkit (WTK) is state-of-the art toolbox for
developing wireless applications that are based on the Java ME platform
Connected Limited Device Configuration (CLDC) and Mobile Information
Device Profile (MIDP), and designed to run on cell phones, mainstream
personal digital assistants, and other small mobile devices.

The toolkit includes the emulation environments, performance optimization
and tuning features, documentation, and examples that developers need to
bring efficient and successful wireless applications to market quickly.



Sun Java Wireless Toolkit 538G APl OE/EFEENINAE - 5538 Java
Community Process (JCP) & API : Java Specification Request (JSR)

Mobile Service Architecture (JSR 248)

Java Technology for the Wireless Industry (JTWI) (JSR 185)
Connected Limited Device Configuration (CLDC) 1.1 (JSR 139)
Mobile Information Device Profile (MIDP) 2.0 (JSR 118)
PDA Optional Packages for the J2ME Platform (JSR 75)
Java APIls for Bluetooth (JSR 82)

Mobile Media APl (MMAPI) (JSR 135)

J2ME Web Services Specification (JSR 172)

Security and Trust Services API for J2ME (JSR 177)
Location API for J2ME (JSR 179)

SIP API for J2ME (JSR 180)

Mobile 3D Graphics API for J2ME (JSR 184)

Wireless Messaging APl (WMA) 2.0 (JSR 205)

Content Handler API (JSR 211)

Scalable 2D Vector Graphics API for J2ME (JSR 226)
Payment AP! (JSR 229)

Advanced Multimedia Supplements (JSR 234)

Mobile Internationalization API (JSR 238)

Java Binding for the OpenGL(R) ES API (JSR 239)

4-3. Sun Product Offering for Constrained Devices-based
on CLDC Configuration

http://java.sun.com/javame/overview/products.isp

For small devices Sun offers a full implementation of an optimized virtual
machine based on CLDC together with a set of optional packages. This
solution is represented by 2 related and closely connected products:

the CLDC HotSpot Implementation (CLDC HI) which is a product that is
compliant with the Java ME Platform CLDC specification and built for

maximum performance within a resource constrained platform.

the Sun Java Wireless Client - which is a pre-integrated and optimized
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solution that enables customers to deploy mobile Java technologies with
quick time-to-market and reduced cost.

This product is pre-integrated and pre-tested with CLDC HI

The product can be bought either as a Standards Pack which includes all
Technology Compatibility Kits for all the included JSRs or it can be licensed
as a Wireless Performance Pack License.

In the Performance Pack the Sun optimized implementation of CLDC and
Sun Java Wireless Client are included as described above.

The Performance Pack License also includes future updates to the Sun
Java Wireless Client, i.e. as new JSRs gets added to the client this will
automatically be made available for the customer to use.

Standards Pack License

B T ree———ry
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Performance Pack License

The next version of the Sun Java Wireless Client will include an extended
set of JSRs and APls. The picture below represents the JSREs included in
the current version of the Sun Java Wireless Client.
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4-4. Connected Limited Device Configuration (CLDC)
HotSpot Implementation

The Connected Limited Device Configuration (CLDC) HotSpot
Implementation is Sun's high-performance Java virtual machine for
resource-constrained wireless phones and communicator-type devices.

The CLDC HotSpot implementation is the recommended virtual machine
technology for new product deployments in this class of devices, and can
be integrated with the Sun Java Wireless Client for a full stack solution
using Java technology.

The goal of optimized implementations are to provide a high-performance,
high-quality, and flexible implementation that reduces cost and time to
market when porting Java ME technologies to targeted handsets.

High Performance - essential for responsive, interactive user experiences
in applications written for the Java programming language

High Quality Code - Emphasis on extensive internal testing and
documentation and enhances quality in terms of code design and
portability

Flexibility - Necessary to support different devices with different processors,
operating systems, and native hardware services

4-5. Sun Java Wireless Client
The Sun Java Wireless Client is an optimized implementation that focuses
on performance, footprint, portability, and extensibility.

The value propositions of the Sun Java Wireless Client are:

1. Simplified integration for MSA Subset (JSR 248) with well defined native
porting interfaces

2. Reduced cost by allowing faster ports, and providing reusable system
modules
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Optimized performance for complete stack and footprint by selective
compilation

Flexible to customize by providing prebuilt and replaceable modules
and build infrastructure
Customizable phone environment through the use of adaptive user

interface technology

Pre-tested with Java Device Test Suite

Sun Java Wireless Client version 1.1.3 today covers the following
technologies:

Mobile Information Device Profile 2.0 (JSR 118)

Mobile Media APIs (JSR 135)

Connected Limited Device Configuration 1.1 (JSR 139)
Wireless Messaging APls (JSR 205)

PIM & File System (JSR 75)

Bluetooth (JSR 82)

XML Parser (JSR 172)

Security & Trust (JSR 177)

3D Graphics (JSR 184)

Scalable Vector Graphics (JSR 226)

Following this version of the Sun Java Wireless Client the next (version
1.1.4) will support the following additional optional JSRs:

Location API for J2ME (JSR 179)

SIP API for J2ME (JSR 180)

Content Handler AP (JSR 211)

Payment APl (JSR 229)

Advanced Multimedia Supplements (JSR 234)
Mobile Internationalization API (JSR 238)
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4-6. Java Device Test Suite (JOTS)

The Java Device Test Suite (JOTS) simplifies quality assurance and
reduces time-to-market for implementations of the Java ME Platform, by
providing comprehensive tests and robust test manager to evaluate,
validate, and verify the quality of implementations of the Connected Limited
Device Configuration (CLDC) and the Mobile Information Device Profile
(MIDP) on a particular device.

The main components of the Java Device Test Suite is shown in the picture
below:

Java Device Test Suite = Quality

Over and above the TCK, tesls check the quality of the

Java implementation and interaction with the underiying
operating system and hardware

™ » Enables quality and

performance testing.

» Allows qualification of

handsels from same andlor

different manufacturers

and software vendors.

» Supports both standard

and optional JSRs.

» Cuslomizable to fit

specific requirements and

use cases.

]
— e et e

% TCK = Gnmpaﬂhlllty_

Specific Java ME Technology API offerings
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The results from the JCP process for each of the JSRs is as described
under Java Community Process a specification, a Reference
Implementation {R1) and a Compatibility Test Kit (CTK).

The reference implementation is not delivered as a commercial product,
therefore most of the code running on devices today are products from
different companies which is based on the specifications.

The picture below represents a summary of the relevant JSRs for the Java
ME Platform. For each JSR where Sun has a Reference Implementation
and a TCK the JSR is highlighted with a red frame.

: Comms Parsona

Documentation for the Java Platform, Micro Edition {Java ME)
http:Mjava sun.comfjavamelreference/apis. jsp
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B A E -~ Mobile Processing

PES R &K

[ Mobile B MEE ) TR0

Mobile Processing #iffEZ74E

5-1. JDK € Update 2

1. FEENE:

hitp:#java.sun.comiavase/downloads/index.jsp

B The Java SE Development Kit (JDK) includes the Java Runtime
Environment (JRE) and command-line development tools that are useful
for developing applets and applications,

2. F7 jdk-Bu2-windows-i586-p.exe.

e B ST Dyl by et e pi i 2 o Ceiomisering ) Sl S X |
e

Custom Setup

St opoornal fearires oo ireal fom e ke below, You can changs yor choce of Teaires after
instalation by using the AddRemove Programs utitty inthe Conkrol Faned

W= B siepanent Tock
_ﬁ_v] Cemos aned Samples
B3 = Source Code
3= Pubk: RE
| 2+ Jwea DB

g fi=H

Cirogram Fees e 160 Oy

5
Sabact the program featunes wou want imstaled #fﬁ'”ff«

Festure Desonphion
AT SE Deavsopmenrt KL G
Lipsdiata 2, I\Il.ﬂ'-ll] private RE

& Update 2, This wil requine
FO0MB o your hard drive
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3. BYE path BE(T : [HAE]> (NS> LR > EERH]>[FirR ] - %
# Path, i FimiE] TRBEMNSHOHEE 1A C\Program
Files\Javaljdk1.6.0_02\bin\ B[ «




5-2. Sun Java Wireless Toolkit for CLDC 2.5.2

1. KA

http:/fava.sun.comfproducts/siwtoolkit/download, htm|
http:/fava.sun com/products/siwtoolkit’zh _tw_download-2 5 2 himil

2. Sun Java Wireless Toolkit (T E#ER J2ZME Wireless Toolkit) & —iHE 1]

Java EFEEIN TR - EWEAIET O Java Technology for the
Wireless Industry (JTWI, JSR 185) (§#ELLE Mobile Service Architecture

(MSA, JSR 248) jRIBEENEEL T - SHIRESSHITIR - 2/
T EEE R -
B & sun_java wireless_toolkit-2 5 2-windows.exe, B #{THE.

B S57E Java ZETTE JOK B, B c:\jdk1.6.0 02

1l " o1 [ — :
Insfaftiid m T {He s | f Corcel -V
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5-3. F7E Sun Java Wireless Toolkit for CLDC & 88EiE

Bl e WTK2.5.2

5 g T TR LN oy Tosag ek w L[ E 7 T = =
H—'ul.#rhlfmhﬁll:rr. N L L RTINS Sl S R S ( TR e [ e )
‘ Chooee Devtnation Locstmn

[Repalfor i : L [T | [fjats ) [ e

Eeury iy T | Woaisewrss Towolhat 257 e CLOC

PH Fobdes
Lyl B0
Frisart Upedsies

. S — -
T | m_qm ‘ | e s | -—_ -ll.l__-- Cancad T




B Apple QuickTime &ERES

NERHEILL:

http://www.apple.com/quicktime/download/
£ Windows | ¥E AMR BEEEFESE, & N&, QuickTimelnstaller.exe,

WP TLE -

B EFENES

€3 Bluetooth

% Notebook RACENRE, TJLBRAR SRBRIBHELEESRINES
L BRENZTN

LRTNE - BERETENA -
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m5 Wireless BRI

BREIER

[ BA 2.4 GHz BRBHBRE

[] & 5 CHz BABHEBR W) PRID)
EY#E

M BREYSRE®
gl

2.4 GHz S TR 8L 01 SGHz SIS RIGMRASTT BT » AR
Dtk EHERIRSAE » A REIRFERE -

FIZ{ER 24 GHz B RIEHERIIESEE TR RGN -

CWE K E T

5-4. Mobile Processing IDE

NI

http://mobile.processing.org/download/mobile-0006-expert.zip

Run Mobile Processing. Choose Preferences from the main drop-down
menu. In the Preferences dialog box, go to the Mobile tab, and enter the
location of the WTK.

From the Help menu, choose Check for updates... to check for and
automatically download the latest versions of the core API and libraries
over the Internet.
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Documentation
hitp://mobile_processing.org/download/docs. zip

1. ;518 mobile-0006-expert.zip BEEEHG T c\mobile-0006-expert HiE [,
147 mobile.exe FEEHREEE -

B& Mobile Processing ALPHA - 0006 ==y =
File Edit Sketch Tools Help

rasalyrmob Yo

int x,¥.t,d,e=100, b, h,v fa=l,fb=1, 00=16,0b=16,F2=2, rl=60, 12=20, 13=-15, f3 =«
rolor colour;

lor colours| == color|257];
int sinArray| J=rew ant[T21):

int xPos, yPos, oldxPos, oldyPos, c, 1;

int tine = TRO_PI/150:

int finc = TWO_PI/1000;

int drawStylesl, wode=2:

vold drsw| )
FIif(e<-10.0 &% t»-10.2) primtln {"fps: " 1*10000/millizg)});

i=0;

backg round (0 );

imi]"
oldsPos=niéfptoi ({rl*=zinf t Hr2®sinl V*F2/32 Mo *san t*E3) ) );

L in ¥

T

Done expording.




2. 9T L /EET% (Sketchbook location), 255% File-> Preferences 5®18, 7+
Preferences ¥551Ed, 7+ General Tab (OE%7E Sketchbook location, BIL:
C:\Users\Jason\Documents\MobileProcessing,

 [Eife) Edit Sketch Tools Help

New Ctri+N
Sketchbook

Save Ctrl+S

Save As.. Ctrl+Shift+S
Export MIDlet  Ctrl+Shift+E
Export Applet

Page Setup Ctrl+Shift+p

Print Ctrl+pP

Preferences Ctri+Comma

Quit Ctrl+Q

[7] Use multiple jor files when exporting spplets

"] Prompt for name when opening or creating a sketch

[¥/] Delete empty sketches on Quit

Sketchbook location: 7
C\Users‘Jason\Docmnents\Mab:lercemlg 3 [-Bmws;e '

Editor font size: (requares restart of Pmcesa&ng)i 12
{7} Set maximum available memory o ‘256 v %MB

7] Use external editor

Maore preferences can be edited dwectly i the file
C\Users\ason\A ppData‘\Roaming\MobileProcessing\preferences. tet
{edit ondy when Processng is not rannmng)

| ok ]| Cencel |
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3. ERTE Wireless Toolkit location, 7+ Preferences ¥Jz542, 7+ Mobile Tab
PEZE Wireless Toolkit location, §3]: C:\WTK2.5.2, DIKEFE CLDC
Version £ 1.1, MIDP Version & 2.0

Wireless Toolkit location:
CAWTK252
CLDC Version:

More preferences can be edited directly i the fils
C W sersVasoni\A ppData\Roaming\MobileProcessing\preferences bt
{edst only when Processing 13 not noning)

| 0K || Cancel

5-5. ¢ Java ME JSR 21 B ZI2ERE

http://mobile.processing.org/phones/index.php
hitp://mobile.processing.org/phones/list.php
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1. BEEP—{EF ISR
I} Nokia N73 /5

Nokia N73

Configuration

Profiles

Screen (w x h)
Fullscreen (w x h)
Colors

Alpha (levels)

Library compatibility

CLDC-1.1
MIDP-2.0
240 x 234
240 x 320
16777216
256

Bluetooth
Imagez2
Messaging

Phone

Scund

video (playback)
video (srapshot)

XML

Multimedia MMAPI Versicn

Supports Mixing

Audic Capture

Vvideo Capture

Recording

video Encodings

Audic Encodings

Snapshot Encodings

Streaming

68

yes
ves
yes
yes
yes
ves
yes

yES

1.1

ves
yes
ves
yes

video/3gpp
video/3gpp2
video/mpd

audio/wav
audio/x-wav
audic/basic
audio/x-au
audic/au
audio/x-basic
audiofamr
audio/mpd
pom

ulaw

gsm

png

- jpeg

image’/png
imagedipeq
image/ipg
image/gif
image/bmp

None



#875E ~ Mobile Processing

FREF

[ Mobile 503 MEBIE 1 TFLG

Mobile Processing

1. B2 Mobile Processing i i 5

B8 mMobile Processing ALPHA - D006 = EoR Fx"
File Edit Skeich Tools Help

x -r.pn.-n.—uq..-._—_lﬂ-.!-r.a-
i o

- #' -
s :_l;-:__l:_ 1 1 5- . 122
int 2.y 0.4 m=l00, b, b v Fanl Fhel ssnld abeld 222 ri=fl, r2=20, ri=-15, f1=
i1 colour; d

r colours| Jsnew color|257];

ink sinArray| |enew 1 Lr]:

t xPos, yPos, oldxPos, oldylos, e, 1
int tine = TRO_PIS150:
£ Finc = THWO_P1/1000;
t drasGtyles=], wodesd;
18 drwwd )
i 0.0 & println {*fg £* 10000
t=l);
backg round (0 ):
=0
oldzPos=wefproi {{ rl®pin t Jerdoiain] ¥ 2/ 32 W Frain 1¥F3)0);

Crone exporling.

a4



2. FIlERRE

3. FUIFRFHEEEES - T RAGEED, -

"1 +9980000 - DefadtColorPhone
MICHeL Wiy HElp

E @ Sun

D LY 45550000 . DefaukColorhane

mIDdet View Help

@ i - & Sun

-l

onndn lanche 0

e
" L [
I ]
A N .4

1 : 2 aac J uiF ] l 1 - Il : 2 anc J ok
gow | 5w [ Guno N
Fews || 8un || Guwn T T
* 0 | #-+ o . 0 =t
SR T . ™ TFALE

4 2 EE REL A MIDlet =

4.1 LI FEHEREDR&RE, Ll rosalymob S5
rosalymob.pde = Mobile Processing [FiETH
rosalymob java = Java Fi1E

T



rosalymob jad > Fi&fERRR T IEE MIDP Java Application

Descriptor

rosalymob.jar > FHEEAZIVRITIE
Hh rosalymob.jad, rosalymob.jar 28 N EFHDHIT.

ra

41 gxam
[ rosalymob jad 2007/10/23 T4 10...
. rosalymob.jar 2007/10/23 T % 10..
__ rosalymob java 2007/10/23 7% 10...
__ rosalymob.pde 2007710723 T4 10...

By

MIDP Java Application Descriptor
Executable Jar File

JAVA @R

PDE B

4.2 [} T2 rosalymob.jad YRR

MIDlet-1: rosalymob, /icon.png, rosalymob

MiDlet-Icon: /icon.png
MiDlet-Name: rosalymob
MIDlet-Version: 1.0.0

MIDlet-Vendor: Mobile Processing ALPHA - 0006

MicroEdition-Profile: MIDP-1.0

MicroEdition-Configuration: CLDC-1.0

MiDlet-Jar-URL: rosalymob.jar

MIDlet-Jar-Size: 44635

5 BHEHENEFH

xip
1KB
44 K8
3KB
3KB

51 REMRFHONVEDTBFHR » WESKRNITESF KBRS RBIRE
o ETEREHE  ABRRFHENEE LBERDRBABR -
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(<I—%@®|T—5m>] [ WA |

5.2 ¥HHE & rosalymob.jad, rosalymob.jar &l £ 48, i EEE
EFEHEUBHER. @ETOrFRME-EE, Ll Nokia N73 B,
BEECSE "FROWEE O .

£ ; e uE p A ]
[ rosstymob jad 2007/10/23 F¥ 10.. MIDPlavaApplicationDescipter 1K8
[eromhmobja  — 2007/10/23 F% 10 Executable Jai File 148
|} rosakymol java EdlitPius [ 1KH
kil KB
Lrosymabpde | amon.
= E Nofon Infernet Secueity BEIA)
HEuetoolh
B UREAEA. | £ 2eEERE
B 2% “midletrar(T) | |
|. EasREs_

13



5.3 TR - BENHEC rosalymob.jad FIBEBZRIETER -

T4



54 WTIET - 28R EIENET BRI P - §57| rosalymob
HET  BREEQATEL - (FORNFRENET-FOLUE)

5



5.5 BRISIET. » S REIAEEE rosalymeb ET L - 9 TFURIE" - I5EE
H BT =

5.6 MERIZT - OFIFAROUNEEE - 28H rosalymob jad » 2 FRIA" - #E
ks "E0S -

[



